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Introduction  

The information in this file applies to IBM® Rational® Test Workbench, version 8.0.1. 

Rational Test Workbench delivers end-to-end functional, regression, load, and integration 

testing to address the quality challenges of highly complex and integrated applications. 

This offering includes the following installable components: 

 IBM Rational Integration Tester is a scripting-free environment for developing 

tests for SOA messaging and business process integration projects. Tests can be 

built by recording existing system behaviors or from requirements, by entering the 

data to send and the data that is expected in return. You can also create virtual 



services to remove test dependencies and enable earlier testing. Virtual services 

can be deployed by Rational Test Virtualization Server to provide on-demand 

virtualized test environments that can support all phases of the test development 

lifecycle. 

 IBM Rational Integration Tester Platform Pack contains technology-specific 

components used by Rational Integration Tester for recording SOA message 

conversations, HTTP(S) and JDBC traffic, and for monitoring middleware 

systems under test with minimal reconfiguration of client applications. 

 IBM Rational Test Control Panel is a server-based web application providing a 

central repository for virtualized services. The Rational Test Control Panel allows 

you to use virtual services published with Rational Integration Tester to create, 

share, and deploy virtualized test environments in Rational Test Virtualization 

Server. 

 IBM Rational Performance Tester is a scripting-free environment for automating 

load and scalability testing of web, ERP, and server-based software applications. 

Rational Performance Tester provides rich and customizable reporting to help you 

identify the presence and cause of system bottlenecks. Rational Performance 

Tester integrates with the Rational Performance Test Server or Rational 

Virtualization Test Server to create large scale, multi-user workloads so that you 

can validate scalability and SLAs for your critical business applications before 

you deploy to production. 

 IBM Rational Functional Tester is an object-driven automated functional testing 

solution for Windows, Java, Web 2.0 and other application environments. 

Storyboard testing combines natural language test narrative with visual editing 

through application screen shots to accelerate the creation of functional tests. A 

variety of wizards further simplify the creation of data-driven tests that are 

resilient to changes in the application UI. 

Important: If you are installing Rational Test Workbench on the same computer as an 

existing version of Rational Functional Tester or Rational Performance Tester, you must 

uninstall the current versions of Rational Functional Tester and Rational Performance 

Tester before beginning the Rational Test Workbench install.  

This document provides the basic information for installing this offering. For detailed 

information about installing each component of this offering, refer to the product 

documentation: 

 IBM Rational Integration Tester, see the IBM Rational Integration Tester setup 

disks documentation folder, or run the launchpad found on the IBM Rational 

Integration Tester Installation Guide disk. 

 IBM Rational Integration Tester Platform Pack, see the IBM Rational Integration 

Tester Platform Pack setup disks documentation folder, or run the launchpad 

found on the IBM Rational Integration Tester Platform Pack Installation Guide 

disk. 



 IBM Rational Test Control Panel, see the IBM Rational Test Control Panel setup 

disks documentation folder, or run the launchpad found on the IBM Rational Test 

Control Panel Installation Guide disk. 

 IBM Rational Performance Tester, see the information center at 

http://pic.dhe.ibm.com/infocenter/rpthelp/v8r3m0/topic/com.ibm.rational.test.lt.in

stall.doc/topics/c_installingproduct.html. 

 IBM Rational Functional Tester, see the information center at 

http://pic.dhe.ibm.com/infocenter/rfthelp/v8r3/topic/com.ibm.rational.test.ft.instal

l.doc/topics/c_overview.html. 

Known issue with upgrades and rollbacks 
 

On the Windows platform, IBM Rational Integration Test Agent, IBM Rational Test 

Control Panel, and IBM Rational Integration Platform Pack Proxy can be installed as 

Windows services. If any of these products have been installed as a Windows service, 

upgrade installations and rollbacks to previous versions fail. The uninstall process 

appears to succeed, but during the installation of the upgraded software (or the previous 

software in the case of a rollback), errors occur, stating that files are in use or cannot be 

removed. 

 

This problem only occurs on the Windows platform and only for products that have been 

installed as services, and can occur whether or not the service is running at the time of 

installation.  

 

The problem is caused because IBM Installation Manager cannot completely remove the 

service during the uninstall process. The service remains in the Windows service list in a 

disabled state until the system is rebooted. While the service is in this state, the upgraded 

service cannot be installed. 

 

To fix this issue: 

1. Stop the Windows service. 

2. Uninstall the existing version of the software. 

3. Reboot the system, 

4. Install the new version.  

 

NOTE: Do not use the upgrade or rollback capability.  

 

When you uninstall Rational Test Control Panel, do not delete the workspace. Note the 

location of the current workspace directory. When you install the new version, enter this 

directory as the workspace location. This preserves all previous settings and published 

stubs.  

 

If you do not know where the workspace directory is, open this file: <RTCP install 

location>\webapps\RTCP\WEB-INF\classes\container.server.properties, and 

find the line that contains the workingDirectory key, for example  
workingDirectory=C\:\\RTW\\RTCP-Workspace 

http://pic.dhe.ibm.com/infocenter/rpthelp/v8r3m0/topic/com.ibm.rational.test.lt.install.doc/topics/c_installingproduct.html
http://pic.dhe.ibm.com/infocenter/rpthelp/v8r3m0/topic/com.ibm.rational.test.lt.install.doc/topics/c_installingproduct.html
http://pic.dhe.ibm.com/infocenter/rfthelp/v8r3/topic/com.ibm.rational.test.ft.install.doc/topics/c_overview.html
http://pic.dhe.ibm.com/infocenter/rfthelp/v8r3/topic/com.ibm.rational.test.ft.install.doc/topics/c_overview.html


 

If you do not follow this process, and the installation fails, follow these steps: 

1. Reboot the system to clear out the service.  

2. Confirm that the service has been removed from the list of Windows services. 

3. Manually delete the contents of the installation directory.   

4. Start a new installation. 

 

If the Rational Test Control Panel workspace is located inside its installation directory 

(which is not recommended) do not to delete this directory or you will lose all Rational 

Test Control Panel configurations. 

 

This problem exists in version 8.0 and later. The workaround described here applies to 

upgrades to the fixpack versions 8.0.0.1 and later. 

 

This issue has been fixed for version 8.0.1 release and later, so that upgrades from 8.0.1 

to fix packs and releases made at a later date will not encounter this problem. 

Installation conventions and terminology 

Understanding these terms and conventions can help you take full advantage of the 

installation information and this product. 

The following conventions are used in ths installation informatoin: 

 The default installation directory is written as  

C:\installation_directory\product\inst.file.  

 The default log location for installation information is C:\log_file_dir\log.txt  

These terms are used in this documentation. 

Installation directory 

The location of product artifacts after the package is installed. 

Package 

An installable unit of a software product. Software product packages are separately 

installable units that can operate independently from other packages in the product. 

Package group 

A package group is a directory in which different product packages share resources with 

other packages in the same group. When you install a package using IBM Installation 

Manager, you can create a new package group or install the packages into an existing 

package group. Eclipse-based packages installed in the same package group are able to 



use the shell-sharing features of Eclipse. Some packages cannot share a package group, in 

which case the option to use an existing package group is unavailable. 

Repository 

A storage area for installable software packages. A repository can be disk media, a folder 

on a local hard disk, or a server or web location. 

Shared directory 

In some instances, product packages can share resources. These resources are located in a 

directory that the packages share. 

Installation Manager overview 

Installation Manager is a program for installing, updating, and modifying packages. It 

helps you to manage the IBM applications, or packages, that it installs on your computer. 

Installation Manager also helps you to keep track of what you have installed, determine 

what is available for you to install, and to organize installation directories. 

Installation Manager provides features that help you keep packages up to date, modify 

packages, manage the licenses for your packages, and uninstall packages. 

Installation Manager includes six wizards that make it easy to maintain packages: 

 The Install wizard walks you through the installation process. You can install a 

package by simply accepting the defaults or you can modify the default settings to 

create a custom installation. Before you install, you get a complete summary of 

your selections throughout the wizard. Using the wizard, you can install one or 

more packages at one time.  

 The Update wizard searches for available updates to packages that you have 

installed. An update might be a released fix, a new feature, or a new version of the 

product. Details of the contents of the update are provided in the wizard. You can 

choose whether to apply an update. The Update wizard searches connected 

repositories for updates. If you are not connected to the Internet, you may not see 

newly available updates for your installed products. To apply an update to a 

computer that is not connected to the Internet, you must download the update and 

extract it to a local repository.  

 The Modify wizard helps you modify certain elements of a package that you have 

already installed. During the first installation of the package, you select the 

features that you want to install. Later, if you require other features, you can use 

the modify packages wizard to add them to your package. You can also remove 

features and add or remove languages.  

 The Manage Licenses wizard helps you set up the licenses for your packages. Use 

this wizard to change your trial license to a full license, to set up your servers for 

floating licenses, and to select which type of license to use for each package. 



Some IBM Rational testing products require runtime floating license keys to run 

tests with multiple virtual users and to use product extensions such as protocols. 

Runtime floating license keys are not managed using Installation Manager. Use 

the License Key Administrator program (which is available on separate media) to 

manage runtime floating license keys. 

 The Roll Back wizard helps you to revert to a previous version of a package.  

 The Uninstall wizard removes a package from your computer. You can uninstall 

more than one package at a time.  

Installation Locations 

Installation Manager retrieves product packages from specified repositories and installs 

the products into selected locations, which are referred to as package groups. 

Package groups 

During installation, you specify a package group into which to install a product.  

 A package group represents a directory in which products share resources.  

 When you install a product by using Installation Manager, you either create a 

package group or install the product into an existing package group. A new 

package group is assigned a name automatically; however, you choose the 

installation directory for the package group.  

 After you create a package group, you cannot change the installation directory. 

The installation directory contains files and resources that are shared by the 

products that are installed into that package group.  

 Product resources that are designed to be shared with other packages are installed 

in the shared resources directory. Not all products can share a package group, in 

which case the option to use an existing package group is disabled.  

 When you install multiple products at the same time, all products are installed into 

the same package group.  

Shared resources directory 

The shared resources directory is where product resources are installed so that they can 

be used by multiple product package groups. You define the shared resources directory 

the first time that you install the first product package. For best results, use your largest 

disk drive for shared resources directories. You cannot change the directory location 

unless you uninstall all product packages. 

Important: When installing products on the Windows Vista operating system, do not 

create the shared resources directory in the Program Files directory (C:\Program Files\). 

Otherwise, users without Administrator privileges will be unable to use the product. 

Coexistence 



Some products are designed to coexist and share functions when they are installed in the 

same package group. A package group is a location where you can install one or more 

software product packages. 

Offering coexistence considerations 

When you install each product package, you select whether to install the product package 

into an existing package group or to create a package group. Installation Manager 

prevents you from installing products into package groups products that are not designed 

to share or do not meet version compatibility and other requirements. To install more 

than one product at a time, the products must be able to share a package group. 

Any number of eligible products can be installed to a package group. When a product is 

installed, the product functions are shared with all the other products in the package 

group. If you install a development product and a testing product into one package group, 

when you start either of the products, you have both the development and testing 

functions available to you in your user interface. If you add a product with modeling 

tools, all the products in the package group have the development, testing, and modeling 

functions available. 

Installing with your Eclipse instance 

Note: This only applies to Rational Performance Tester and Rational Functional Tester. 

The product package that you install using Installation Manager comes with a version of 

Eclipse, which is the base platform of this product package. If you already have Eclipse 

installed on your workstation, you can add your product package directly to that Eclipse 

installation and extend the functions of the Eclipse integrated development environment 

(IDE). 

Extending an Eclipse IDE adds the functions of the newly installed product, but 

maintains your IDE preferences and settings. Previously installed plug-ins are also still 

available. 

In most cases, your current Eclipse IDE must be the same version as the Eclipse that the 

product you are installing uses. Installation Manager checks that the Eclipse instance that 

you specify meets the requirements for the installation package and helps you install the 

latest updates from eclipse.org, if required. 

Important: When you install products on the Windows Vista operating system, do not 

install Eclipse in the Program Files directory (C:\Program Files\). Otherwise, users 

without Administrator privileges are unable to use the product. 

Installation repositories 

Installation Manager retrieves product packages from specified repository locations. 



If the launchpad is used to start Installation Manager, the repository information is passed 

to Installation Manager. If the Installation Manager is started directly, you must specify 

an installation repository that contains the product packages that you want to install.  

Some organizations bundle and host their own product packages on their intranet. Your 

system administrators will need to provide you with the correct URL. 

By default, Installation Manager uses an embedded URL in each Rational software 

delivery product to connect to a repository server over the Internet. Installation Manager 

then searches for the product packages as well as new features. 

Setting repository preferences in Installation Manager 

When you start the installation of Rational Test Workbench from the launchpad program, 

the location of the repository that contains the product package you are installing is 

automatically defined in Installation Manager when it starts. However, if you start 

Installation Manager directly (for example, installing IBM Rational Test Workbench 

from a repository located on a web server) then you must specify the repository 

preference (the URL for the directory that contains the product package) in Installation 

Manager before you can install the product package.  

Specify these repository locations on the Repositories page of the Preferences window. 

By default, Installation Manager uses an embedded URL in each Rational software 

development product to connect to a repository server through the Internet and search for 

installable packages and new features. Your organization might require you to redirect 

the repository to use intranet sites. 

Note: If you are installing from a remote server, before starting the installation process, 

be sure to obtain the installation package repository URL from your administrator.  

To specify repositories in Installation Manager: 

1. Start Installation Manager.  

2. On the Start page of Installation Manager, click File > Preferences, and then 

click Repositories. The Repositories page opens, showing any available 

repositories, their locations, and whether they are accessible.  

3. On the Repositories page, click Add Repository.  

4. In the Add repository window, type the URL of the repository location or browse 

to it and set a file path.  

5. Click OK. If you provided an HTTPS or restricted FTP repository location, then 

you will be prompted to enter a user ID and password. The new or changed 

repository location is listed. If the repository is not accessible, a red x is displayed 

in the Accessible column.  

6. Click OK to exit.  

7. For Installation Manager to search the default repository locations for the installed 

packages, ensure the preference Search service repositories during installation 



and updates on the Repositories preference page is selected. This preference is 

selected by default.  

Installing Rational Test Workbench on Windows or Linux 

The Setup disk includes the launchpad program, which provides you with a single 

location to start the installation process. 

Use the launchpad program to start the installation of software in these cases: 

 Installing from product CDs  

 Installing from an electronic image on your local file system  

 Installing from an electronic image on a shared drive  

For products that are installed by Installation Manager for the Rational Software Delivery 

Platform, starting the installation process from the launchpad program causes Installation 

Manager to be automatically installed if it is not already on your computer. Furthermore, 

the installation process is already configured with the location of the repository that 

contains the installation package. If you install Installation Manager separately, you must 

configure the repository preferences manually. Also, you can start the installation of a 

number of supporting software items from the launchpad. 

Starting the launchpad 

To install the product, start the launchpad program. 

Depending on the source of the product installation, follow one of these procedures to 

start the launchpad program. 

If you are installing from the CDs, complete these steps: 

1. Insert the Setup CD into your CD drive.  

2. On Linux, mount the CD drive  

3. If autorun is enabled on your computer, the launchpad program starts 

automatically. If the launchpad does not start automatically, complete one of these 

steps:  

 On Windows, run the launchpad.exe command, which is located in the root 

directory of the CD.  

 On Linux, run the launchpad.sh, which is located in the root directory of the 

CD.  

If you are installing from electronic disks that you downloaded from IBM Passport 

Advantage®, open a command line, and change to the directory where you extracted the 

disk images; and then at the command prompt, complete one of these steps: 



 On Windows, enter RTW_SETUP\launchpad.exe.  

 On Linux, enter RTW_SETUP/launchpad.sh.  

The launchpad program starts. 

Starting installation from the setup disk 

Note: You must have Administrator privileges to perform this installation. 

Depending on the source of your product installation, complete one of these procedures 

to install the product. 

If you are installing from the CDs, follow these steps: 

1. Insert the Setup CD into your CD drive.  

2. On Linux, mount the CD drive.  

3. If autorun is enabled on your computer, the launchpad program starts 

automatically. Stop the launchpad program.  

4. In a command line, change to the root of the Setup disk, and complete one of 

these steps:  

 On Windows, enter InstallerImage_win32\install.exe.  

 On Linux, enter InstallerImage_linux/userinst.  

If you are installing from electronic disks that you downloaded from Passport Advantage, 

open a command line, and change to the directory where you extracted the disk images; 

then complete one of these steps: 

 On Windows, enter RTW_SETUP\InstallerImage_win32\install.exe.  

 On Linux, enter RTW_SETUP/InstallerImage_linux/install.   

When the install program starts, Installation Manager is installed if it is not already on 

your computer. Furthermore, Installation Manager is configured with the location of the 

repository (installation files) for IBM Rational Test Workbench. 

 Install the product software 

By starting the installation process from the launchpad program, Installation Manager is 

automatically installed if it is not already on your computer, and it starts preconfigured 

with the location of the repository that contains the product package. If you install and 

start Installation Manager directly, then you must set repository preferences manually. 

To learn how to install the product from a command prompt in silent mode, see the 

Installing Silently section of the Installation Manager Information Center. 

To install the product from the launchpad: 



1. If you are installing from compressed files, such as .zip or ISO files, extract the 

files into a common directory. Extract the disk images to directories that are 

named /disk1, /disk2, and so on. Extract the Setup disk image to a directory that is 

named RTW_SETUP. The Setup disk contains the launchpad program. 

2. If you are installing from a CD, insert the first product disk into your CD drive. If 

autorun is enabled on your workstation, then the launchpad starts automatically. 

Otherwise, start the launchpad program manually.  

 On Windows, run the launchpad.exe command, which is located in the root 

directory of the Setup disk installation image.  

 On Linux, run the launchpad.sh command, which is located in the root 

directory of the Setup disk installation image.  

3. Optional: Select a language in which to run the launchpad and Installation 

Manager.  

4. Select the product to install from the launchpad menu. The Install Packages 

window opens.  

5. Click each of the product packages to highlight them. The description of the 

package is displayed in the Details pane at the bottom of the screen. The packages 

are:  

IBM Rational Integration Tester  

IBM Rational Performance Tester  

IBM Rational Functional Tester  

IBM Rational Integration Tester Platform Pack  

IBM Rational Test Control Panel  

 To view all updates that are found for the available packages, click Show all 

versions.  

 To display a package description in the Details pane, click the package name. 

If additional information about the package is available, such as a readme file 

or release notes, a More info link is included at the end of the description text. 

Click the link to display the additional information in a browser. To fully 

understand the package that you are installing, review all information.  

Note: For Installation Manager to search the predefined IBM update 

repository locations for the installed packages, the Search the linked 

repositories during installation and updates preference on the Repositories 

preference page must be selected. This preference is selected by default. 

Internet access is also required. A progress indicator shows that the search is 

taking place. You can install updates at the same time that you install the base 

product package.  



6. Select the product package and any updates to the package to install. Updates that 

have dependencies are automatically selected and cleared together. Click Next to 

continue.  

7. On the Licenses page, read the license agreement for the selected package. If you 

selected more than one package to install, there might be a license agreement for 

each package. On the left side of the License page, click each package version to 

display its license agreement. The package versions that you selected to install 

(for example, the base package and an update) are listed under the package name.  

If you have purchased an Authorized User license with Rational Test Workbench, 

you receive these four license activation kits: 

 Rational Performance Tester  

 Rational Functional Tester  

 Rational Integration Tester  

 Rational Performance Tester PVU  

The Rational Performance Tester PVU license activation kit enables you to 

import the Rational Performance Tester PVU license activation kit so that you can 

leverage all the capabilities of Rational Performance Tester agents that are 

associated with the Rational Performance Test Server and Rational Test 

Virtualization Server offerings, including the ability to run virtual users on those 

agents without Virtual Tester pack licenses. If you agree to the terms of all of the 

license agreements, click I accept the terms of the license agreements. Click 

Next to continue.  

8. On the Location page, the location of the package group into which each product 

will be installed is displayed. Click on each product to see its package group 

location. Optionally, you can enter another location for the package group in the 

Installation Directory field. Click Next to continue. 

 

9. When you are installing Rational Performance Tester, the “Configuration for IBM 

Rational Performance Tester Agent” window displays. Select the IBM Rational 

Performance Tester checkbox so that you can import the Rational Performance 

Tester PVU license activation kit, which enables you to leverage all the 

capabilities of Rational Performance Tester agents. If you do not select this 

option, you will need Virtual Tester pack licenses to run more than 5 users, even 

though Rational Performance Tester agents installed with Rational Performance 

Test Server and Rational Test Virtual Server are licensed by Processor Virtual 

Unit (PVU) licensing. 

10. On the Features page, select the package features to install.  

a. Optional: To see the dependency relationships between features, select Show 

Dependencies. 

b. Optional: Click a feature to view its brief description under Details.  



c. Select or clear features in the packages. Installation Manager automatically 

enforces any dependencies with other features and displays updated download 

sizes and disk space requirements for the installation.  

d. When you are installing Rational Performance Tester, select the IBM 

Rational Test Workbench Processor Value Unit (PVU) support checkbox 

so that after the installation completes, you can use the Manage License 

function of Installation Manager to import the Rational Performance Tester 

PVU license activation kit. This enables you to leverage all the capabilities of 

Rational Performance Tester agents. If you do not select this feature during 

the installation, you can use the Modify Packages function of Installation 

Manager to select it after the installation completes. 

e. When you are finished selecting features, click Next to continue.  

11. On the common licensing configuration page, if you are using Floating or Token 

licenses, type the TCP/IP port number and host name of the license servers to use to 

configure licensing on the workbench computer. Separate the port number and host 

name with the at sign (@). Separate the port-host pairs with semicolons (;). To use the 

default port, omit the port number. If you do not know the port numbers and names of 

license servers to use, you can configure the license servers after installation by using 

Rational License Key Administrator. For example, to configure three license servers 

that are named license1, license2, and license3 to use port 27000, the default port, and 

port 1765 respectively, enter this text: 
27000@license1;@license2;1765@license3 

Note: If you are using Authorized User licensing, you do not need to configure your 

license. 

12. On the Summary page, review your choices before installing the product package. To 

change the choices that you made on previous pages, click Back, and make your 

changes. When you are satisfied with your installation choices, click Install to install 

the package. A progress indicator shows the percentage of the installation that is 

completed.  

13. When the installation process is complete, a message confirms the completion of the 

process.  

14. Click View log file to open the installation log file for the current session in a new 

window. You must close the Installation Log window to continue.  

15. Click Finish to start the selected package. The Install Package wizard closes and you 

are returned to the launchpad program.  

16. License the product.  

Managing Licenses 

Using the Manage Licenses wizard, you can apply a license to a product or upgrade trial 

versions of an offering to a licensed version by importing a product activation kit. You 

can also enable floating license enforcement for offerings with trial or permanent licenses 

to use floating license keys from a license server. 

For more information about managing licenses for your Rational product, see these 

resources:  



 The technote that describes Rational product activation licensing at     

http://www.ibm.com/support/docview.wss?uid=swg21250404 

 The Rational licensing support page at 

http://www.ibm.com/software/rational/support/licensing/ 

 The Rational Common Licensing information center at 

http://publib.boulder.ibm.com/infocenter/rational/v0r0m0/index.jsp  

 The IBM License Metric Tool page to learn about processor virtualization unit 

licensing at 

http://publib.boulder.ibm.com/infocenter/tivihelp/v53r1/index.jsp?topic=%2Fcom

.ibm.lmt75.doc%2Fcom.ibm.license.mgmt.admin.doc%2Ft_importing_software_

catalogs.html 

License descriptions 

As a purchaser of an IBM Rational software product, you can choose from four types of 

product licenses: 

 Authorized User licenses  

 Floating licenses  

 Token licenses  

 Processor value unit licensing 

The best choice for your organization depends upon how many people use the product, 

how often they require access, and how you prefer to purchase software. 

Authorized User licenses 

An IBM Rational Authorized User license authorizes an individual to use a Rational 

software product. Purchasers must obtain an Authorized User license for each individual 

user who accesses the product in any manner. An Authorized User license cannot be 

reassigned unless the purchaser replaces the original assignee on a long-term or 

permanent basis. 

For example, if you purchase one Authorized User license, you can assign that license to 

one individual who can use the Rational software product exclusively. The Authorized 

User license does not authorize a second individual to use that product at any time, even 

if the licensed individual is not using the product. 

Floating licenses 

An IBM Rational Floating license is a license for a single software product that can be 

shared among multiple team members; however, the total number of concurrent users 

cannot exceed the number of floating licenses you purchase. For example, if you 

purchase one floating license for a Rational software product, then any user in your 

organization can use the product at any given time. Another person who wants to access 

the product must wait until the current user logs off.  

http://www.ibm.com/support/docview.wss?uid=swg21250404
http://www.ibm.com/software/rational/support/licensing/
http://publib.boulder.ibm.com/infocenter/rational/v0r0m0/index.jsp
http://publib.boulder.ibm.com/infocenter/tivihelp/v53r1/index.jsp?topic=%2Fcom.ibm.lmt75.doc%2Fcom.ibm.license.mgmt.admin.doc%2Ft_importing_software_catalogs.html
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To use floating licenses, you must obtain floating license keys and install them on a 

Rational License Server. The server responds to user requests for access to the license 

keys; the server grants access to the number of concurrent users that equals the number of 

licenses the organization purchased. 

Token licenses 

The token-based license model means that you can buy a certain number of token 

licenses. If you use a Rational tool that checks out a feature that is token-based, the 

feature line in the license file specifies the number of tokens that are checked out. Token-

based licenses can only be used with floating licenses. They cannot be used for 

authorized user license. For more details about token licensing, contact your local IBM 

marketing representative. 

Processor value unit (PVU)  licensing 

Processor value unit (PVU) licensing provides the means for IBM to introduce pricing 

structures that are responsive to both the type and number of processors available to 

installed products. 

Entitlements can be full capacity or subcapacity. Under the processor value unit licensing 

structure, you license software based on the number of value units assigned to each 

processor core. For example, processor type A is assigned 80 value units and processor 

type B is assigned 100 value units. If you license a product to run on two type A 

processors, you must acquire an entitlement for 160 value units. If the product is to run 

on two type B processors, the required entitlement is 200 value units. 

The processor value units table, which assigns a number of value units to each supported 

processor type, is regularly updated to provide for the introduction of new processor 

technologies. Agents retrieve information about the number and type of processor on the 

monitored computer or partition and the table is used to determine the level of license use 

in terms of processor value units. 

For more information about managing licenses for your Rational product, see the IBM 

License Metric Tool page to learn about processor virtualization unit licensing at 

http://publib.boulder.ibm.com/infocenter/tivihelp/v53r1/index.jsp?topic=%2Fcom.ibm.lm

t75.doc%2Fcom.ibm.license.mgmt.admin.doc%2Ft_importing_software_catalogs.html 

 

Enabling licenses 

If you are installing the software for the first time or want to extend a license to continue 

using the product, you have options on how to enable licensing for your product. 

Licenses for this product are enabled in three ways: 

http://publib.boulder.ibm.com/infocenter/tivihelp/v53r1/index.jsp?topic=%2Fcom.ibm.lmt75.doc%2Fcom.ibm.license.mgmt.admin.doc%2Ft_importing_software_catalogs.html
http://publib.boulder.ibm.com/infocenter/tivihelp/v53r1/index.jsp?topic=%2Fcom.ibm.lmt75.doc%2Fcom.ibm.license.mgmt.admin.doc%2Ft_importing_software_catalogs.html


 Importing a product activation kit  

 Enabling Rational Common Licensing to obtain access to floating license key  

Activation kits 

The Product Activation Kit CD contains the permanent license key for you product. You 

use Installation Manager to import the activation kit to your product. 

Floating license enforcement 

Optionally, you can obtain floating license keys, install IBM Rational License Server, 

and enable floating license enforcement for your product. Floating license enforcement 

provides these benefits: 

 License compliance enforcement throughout the organization  

 Fewer license purchases  

 License keys served for IBM Rational Team Unifying and Software Delivery 

Platform desktop products from the same license server  

 Some versions of Rational products require an upgraded version of the Rational 

License Server. See this support article for license upgrade information: 

http://www.ibm.com/support/docview.wss?uid=swg21250404  

For more information about obtaining activation kits and floating licenses, see Purchasing 

licenses. 

Purchasing licenses 

You can purchase new licenses if your current product license is about to expire or to 

acquire additional product licenses for team members. 

To purchase a new license: 

1. Determine the type of license to purchase.  

2. Go to ibm.com or contact your IBM sales representative to purchase the product 

license. For details, visit the IBM web page on How to buy software.  

3. Depending on the type of license you purchase, use the Proof of Entitlement that 

you receive and complete one of these steps to enable your product:  

4. If you purchase Authorized User licenses for your product, go to IBM Passport 

Advantage, and follow the instructions there for downloading your product 

activation kit. After you have downloaded the activation kit, import the product 

activation .jar file by using Installation Manager.  

Back up the product activation .jar file. If you uninstall the product and then install the 

product again, you might need to use the product activation .jar file to license the product 

again. 

http://www.ibm.com/support/docview.wss?uid=swg21250404
http://www.ibm.com/support/docview.wss?uid=swg21250404


 If you purchase floating licenses for your product, go to the IBM Rational 

Licensing and Download Center, log in (IBM registration is required), and then 

click the link to connect to the IBM Rational License Key Center. There you can 

use your Proof of Entitlement to obtain floating license keys for your license 

server.  

Optionally, you can go to IBM Passport Advantage to download the activation kit for 

your product. After importing the activation kit, you can switch from a floating to a 

permanent license type if you use your computer offline for long periods. 

To import the activation kit or enable floating license support for your product, use the 

Manage Licenses wizard in Installation Manager. 

Viewing license information for installed packages 

You can review license information for your installed packages, including license types 

and expiration dates, from Installation Manager. 

To review your license information: 

1. Start Installation Manager.  

2. On the main page, click Manage Licenses.  

The package vendor, current license types, and expiration dates are displayed for each 

installed package. 

Contacting IBM Software Support 
If the self-help resources have not provided a resolution to your problem, you can contact 

IBM Software Support. IBM Software Support provides assistance in resolving product 

issues. 

Prerequisites 

To submit your problem to IBM Software Support, you must have an active Passport 

Advantage® software maintenance agreement. Passport Advantage is the IBM 

comprehensive software licensing and software maintenance (product upgrades and 

technical support) offering. You can enroll online in Passport Advantage from 

http://www.ibm.com/software/lotus/passportadvantage/howtoenroll.html 

 To learn more about Passport Advantage, visit the Passport Advantage FAQs at 

http://www.ibm.com/software/lotus/passportadvantage/brochures_faqs_quickguid

es.html. 

 For further assistance, contact your IBM representative. 

To submit your problem online (from the IBM website) to IBM Software Support, you 

must additionally: 

http://www.ibm.com/software/lotus/passportadvantage/howtoenroll.html
http://www.ibm.com/software/lotus/passportadvantage/brochures_faqs_quickguides.html
http://www.ibm.com/software/lotus/passportadvantage/brochures_faqs_quickguides.html


 Be a registered user on the IBM Support website. For details about registering, 

see Registering on the IBM Software Support website. 

 Be listed as an authorized caller in the service request tool. 

Procedure 

1. Determine the business impact of your problem. When you report a problem to 

IBM, you are asked to supply a severity level. Therefore, you need to understand 

and assess the business impact of the problem that you are reporting.  

Option Description 

Severity 

1 

The problem has a critical business impact: You are unable to use the 

program, resulting in a critical impact on operations. This condition 

requires an immediate solution. 

Severity 

2 

This problem has a significant business impact: The program is usable, 

but it is severely limited. 

Severity 

3 

The problem has some business impact: The program is usable, but less 

significant features (not critical to operations) are unavailable. 

Severity 

4 

The problem has minimal business impact: The problem causes little 

impact on operations or a reasonable circumvention to the problem was 

implemented. 

2. Describe your problem and gather background information, When describing a 

problem to IBM, be as specific as possible. Include all relevant background 

information so that IBM Software Support specialists can help you solve the 

problem efficiently. To save time, know the answers to these questions: 

 What software versions were you running when the problem occurred? 

 To determine the exact product name and version, use the option applicable to 

you:  

o Start the IBM Installation Manager and select File > View Installed 

Packages. Expand a package group and select a package to see the 

package name and version number. 

o Start your product, and click Help > About to see the offering name 

and version number. 

 What is your operating system and version number (including any service 

packs or patches)?  

 Do you have logs, traces, and messages that are related to the problem 

symptoms? 

 Can you recreate the problem? If so, what steps do you perform to recreate the 

problem? 

 Did you make any changes to the system? For example, did you make changes 

to the hardware, operating system, networking software, or other system 

components? 



 Are you currently using a workaround for the problem? If so, be prepared to 

describe the workaround when you report the problem. 

3. Submit your problem to IBM Software Support. You can submit your problem to 

IBM Software Support in the following ways: 

 Online: Go to the IBM Rational Software Support website at 

https://www.ibm.com/software/rational/support/ and in the Rational support 

task navigator, click Open Service Request. Select the electronic problem 

reporting tool, and open a Problem Management Record (PMR), describing 

the problem accurately in your own words. 

o For more information about opening a service request, go to 

http://www.ibm.com/software/support/help.html 

o You can also open an online service request using the IBM Support 

Assistant. For more information, see Using the IBM Support Assistant 

to open a service request 

 By phone: For the phone number to call in your country or region, go to the 

IBM directory of worldwide contacts at http://www.ibm.com/planetwide/ and 

click the name of your country or geographic region.  

 Through your IBM Representative: If you cannot access IBM Software 

Support online or by phone, contact your IBM Representative. If necessary, 

your IBM Representative can open a service request for you. You can find 

complete contact information for each country at 

http://www.ibm.com/planetwide/. 

If the problem you submit is for a software defect or for missing or inaccurate 

documentation, IBM Software Support creates an Authorized Program Analysis Report 

(APAR). The APAR describes the problem in detail. Whenever possible, IBM Software 

Support provides a workaround that you can implement until the APAR is resolved and a 

fix is delivered. IBM publishes resolved APARs on the Software Support website daily, 

so that other users who experience the same problem can benefit from the same 

resolution. 

Notices and trademarks 

© Copyright IBM Corporation 2001, 2012. 

U.S. Government Users Restricted Rights - Use, duplication or disclosure restricted by 

GSA ADP Schedule Contract with IBM Corp. 

This information was developed for products and services offered in the U.S.A. 

IBM may not offer the products, services, or features discussed in this documentation in 

other countries. Consult your local IBM representative for information on the products 

and services currently available in your area. Any reference to an IBM product, program, 
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or service is not intended to state or imply that only that IBM product, program, or 

service may be used. Any functionally equivalent product, program, or service that does 

not infringe any IBM intellectual property right may be used instead. However, it is the 

user's responsibility to evaluate and verify the operation of any non-IBM product, 

program, or service. 

IBM may have patents or pending patent applications covering subject matter described 

in this document. The furnishing of this document does not grant you any license to these 

patents. You can send license inquiries, in writing, to: 

IBM Director of Licensing 

IBM Corporation 

North Castle Drive 

Armonk, NY 10504-1785 

U.S.A. 

For license inquiries regarding double-byte (DBCS) information, contact the IBM 

Intellectual Property Department in your country or send inquiries, in writing, to: 

Intellectual Property Licensing 

Legal and Intellectual Property Law 

IBM Japan, Ltd. 

19-21, Nihonbashi-Hakozakicho, Chuo-ku 

Tokyo 103-8510, Japan 

The following paragraph does not apply to the United Kingdom or any other 

country where such provisions are inconsistent with local law: INTERNATIONAL 

BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" 

WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, 

INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-

INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR 

PURPOSE. Some states do not allow disclaimer of express or implied warranties in 

certain transactions, therefore, this statement may not apply to you. 

This information could include technical inaccuracies or typographical errors. Changes 

are periodically made to the information herein; these changes will be incorporated in 

new editions of the publication. IBM may make improvements and/or changes in the 

product(s) and/or the program(s) described in this publication at any time without notice. 

Any references in this information to non-IBM Web sites are provided for convenience 

only and do not in any manner serve as an endorsement of those Web sites. The materials 

at those Web sites are not part of the materials for this IBM product and use of those Web 

sites is at your own risk. 

IBM may use or distribute any of the information you supply in any way it believes 

appropriate without incurring any obligation to you. 



Licensees of this program who wish to have information about it for the purpose of 

enabling: (i) the exchange of information between independently created programs and 

other programs (including this one) and (ii) the mutual use of the information which has 

been exchanged, should contact: 

IBM United Kingdom Limited  

Intellectual Property Law  

Hursley Park  

Winchester  

SO21 2JN  

Hampshire  

United Kingdom  

Such information may be available, subject to appropriate terms and conditions, 

including in some cases, payment of a fee. 

The licensed program described in this document and all licensed material available for it 

are provided by IBM under terms of the IBM Customer Agreement, IBM International 

Program License Agreement or any equivalent agreement between us. 

Any performance data contained herein was determined in a controlled environment. 

Therefore, the results obtained in other operating environments may vary significantly. 

Some measurements may have been made on development-level systems and there is no 

guarantee that these measurements will be the same on generally available systems. 

Furthermore, some measurements may have been estimated through extrapolation. Actual 

results may vary. Users of this document should verify the applicable data for their 

specific environment. 

Information concerning non-IBM products was obtained from the suppliers of those 

products, their published announcements or other publicly available sources. IBM has not 

tested those products and cannot confirm the accuracy of performance, compatibility or 

any other claims related to non-IBM products. Questions on the capabilities of non-IBM 

products should be addressed to the suppliers of those products. 

All statements regarding IBM's future direction or intent are subject to change or 

withdrawal without notice, and represent goals and objectives only. 

Trademarks and service marks 

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of 

International Business Machines Corp., registered in many jurisdictions worldwide. Other 

product and service names might be trademarks of IBM or other companies. A current 

list of IBM trademarks is available on the Web at “Copyright and trademark information” 

at http://www-01.ibm.com/software/rational/howtobuy/licensing/.  
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Linux is a registered trademark of Linus Torvalds in the United States, other countries, or 
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the United States, other countries, or both. 
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